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Abstract

The differential effects of dopaminergic drugs with different pharmacological profiles were
investigated with respect to spontaneous motor activity in the common marmoset following
pretreatment with a bilateral brain infusion of 6-hydroxydopamine (6-OHDA). Three marmosets
received infusions of 6-OHDA (either 30 or 40 µg/side) into the bilateral dopamine-rich area running
from the substantia nigra to the striatum. The motor activity of the 6-OHDA marmosets was compared
with that of three intact marmosets. Following the administration of apomorphine (0.5 and 1 mg/kg,
subcutaneously), the 6-OHDA group showed a tendency toward a brief increase in activity counts,
suggesting denervation supersensitivity at the dopamine receptors. After the administration of
methamphetamine (1 and 2 mg/kg, subcutaneously), the 6-OHDA group showed a significant decrease
in activity counts, indicating limited dopamine release from the degenerated neurons. After the
administration of L-3,4-dihydroxyphenylalanine (10 and 20 mg/kg, orally), the 6-OHDA group showed
a significant increase in activity counts without hyperexcitation, consistent with the contribution of
exogenous L-3,4-dihydroxyphenylalanine toward dopamine synthesis in the degenerated neurons. The
present findings indicate that bilateral brain infusion of 6-OHDA in the marmoset may have preclinical
utility as a primate model for investigating the behavioral properties of dopaminergic drugs in brains
with dopaminergic neural deficits.

Keywords: apomorphine, bilateral brain infusion, common marmoset, dopaminergic drugs, 6-
hydroxydopamine, L-3,4-dihydroxyphenylalanine, methamphetamine, Parkinson’s disease,
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Introduction

Parkinson’s disease (PD) is an age-related neurodegenerative disorder that is an important and urgent
target of studies in the field of basic neuroscience. Such studies will contribute toward elucidation of
the pathogenesis of PD and evaluation of possible treatments for this disorder.
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Traditionally, neurotoxins such as 1-methyl-4-phenyl-1,2,3,6-tetrahydropyridine (MPTP) and 6-
hydroxydopamine (6-OHDA) have been used to establish PD models in laboratory animals. In primates
and certain strains of mice, MPTP is usually administered peripherally. We previously studied the
neurobehavioral aspects of the MPTP model of PD in the common marmoset, a small primate with a
body size similar to that of a large adult rat (Ando et al., 2008, 2012, 2014). The MPTP marmoset
model of PD has also been used by many other groups (Eslamboli, 2005; Jenner, 2009) and a similar
model is used in macaques (Nagai et al., 2007). MPTP-treated primates provide a useful in-vivo model
of the disease in humans in terms of degenerated dopaminergic neurons and behavioral manifestations.
The model is therefore also useful in the preclinical evaluation of various therapies, including drugs,
deep brain stimulation (Zhang et al., 2012), and the implantation of dopaminergic neurons induced by
stem cells (Emborg et al., 2013; Wolff et al., 2015) as well as induced pluripotent stem cells (Hallett et
al., 2015).

In addition to MPTP, 6-OHDA has been used for preclinical studies of PD, particularly in rodents
(Ungerstedt, 1968). In contrast to MPTP, 6-OHDA does not penetrate the blood–brain barrier and,
therefore, must be infused directly into brain regions when studying specific types of damage to
dopaminergic neurons. In rodent models using 6-OHDA, the toxin is generally infused into either the
right or the left side of the brain in dopaminergic neural areas, such as the medial forebrain bundle
(Baier et al., 2006), where it effectively causes unilateral neural damage. Subsequently, when a
dopamine agonist, such as apomorphine, is administered peripherally, rodents show contralateral
circling behavior because of denervation supersensitivity of the dopaminergic receptors in the damaged
side (Boules et al., 2001). However, when a dopamine releaser, such as amphetamine, is administered
peripherally, the same rodents show ipsilateral circling behavior because of a lower degree of
dopamine release from nerve terminals on the damaged side relative to the intact side. Thus, the 6-
OHDA rodent model, and specifically, measurements of the direction and the frequency of circling
behavior, are useful for qualitative and quantitative assessments of drug action and the behavioral
pharmacological properties of novel compounds that are potential treatments for PD (Kirik et al.,
1998).

Although most studies have utilized 6-OHDA models using rodents, others have used 6-OHDA models
using marmosets (Annett et al., 1990; Eslamboli, 2005; Garea-Rodriguez et al., 2016). In our limited
experience using the 6-OHDA marmoset model, ipsilateral circling was observed following an
injection of apomorphine, but stable contralateral circling was not observed following an injection of
methamphetamine (Ando K, Nishime C and Nishinaka E, unpublished data). However, in the 6-OHDA
rat model, we could observe differential circling dependent on apomorphine and methamphetamine
(Inaji et al., 2005). Therefore, in the present study, we administered bilateral, rather than unilateral,
infusions of 6-OHDA into the brains of marmosets to further study the usefulness of the 6-OHDA
marmoset model for understanding the behavioral actions of dopaminergic drugs.

The aim of the present study was to detect differential behavioral effects among dopaminergic drugs
with different pharmacological actions in the common marmoset following the induction of mild
damage to dopaminergic neurons using 6-OHDA. The dopaminergic drugs tested in the present study
included apomorphine (a dopamine receptor agonist), methamphetamine (which releases dopamine
from nerve terminals), and L-3,4-dihydroxyphenylalanine (L-DOPA, a dopamine precursor and a
therapeutic drug for patients with PD). The acute effects of these drugs on spontaneous motor activity
were evaluated in marmosets pretreated with a bilateral infusion of 6-OHDA into the dopamine-rich
region running from the substantia nigra to the striatum. The spontaneous motor activity counts of the
6-OHDA model marmosets in their individual living cages were compared with those of intact
marmosets that neither received a 6-OHDA infusion nor underwent a sham operation.

In the present behavioral study, which relied in part on objectively measurable motor activity counts,
grossly observable behavioral signs were also recorded and the histology of the 6-OHDA infused
marmoset brains was analyzed. Together, these procedures provided supplemental data on the effects of
the drugs on motor activity.



Finally, the preclinical utility of the 6-OHDA marmoset model as well as its limitations as a primate
model of dopaminergic neural degeneration were evaluated. Our results were compared with those
from a large number of historically accumulated studies on the MPTP marmoset model.

Methods

Ethics statement

The present study was carried out in strict accordance with the recommendations of the Guide for the
Care and Use of Laboratory Animals published by the National Research Council. The study protocol
was reviewed by the Animal Care and Use Committee of the Central Institute for Experimental
Animals and approved by the Institute (CIEA approval number: 13016). The criteria used by the
committee complied with those mandated by the Japanese Law for the Humane Treatment and
Management of Animals. In addition, this study was designed and carried out under the principle of the
three Rs (Replacement, Reduction, and Refinement) for the use of experimental animals (Blakemore et
al., 2012).

Subjects

Healthy adult male common marmosets were obtained from CLEA Japan Inc. (Tokyo, Japan). At the
start of the experiment, the body weights and ages of the animals were between 300 and 436 g and they
were between 2.8 and 6.8 years of age, respectively. After brain infusion of 6-OHDA, the marmosets
were used to investigate the acute behavioral pharmacological effects of dopaminergic drugs on
spontaneous motor activity.

During the experimental period, each marmoset was housed in an individual stainless-steel living cage
(50 cm high, 30 cm wide, and 48 cm deep) with a wire-mesh floor and walls; each cage was placed in
an enclosed box in the same animal room. The animals were supplied with a balanced diet (50 g/day,
CMS-1M; CLEA Japan Inc.) and free access to tap water from feed valves. The temperature and
humidity in the animal room were 25–26°C and 45–50%, respectively, and the room was illuminated
from 08:00 to 20:00 h.

Bilateral infusion of 6-hydroxydopamine into the brain

Each marmoset was anesthetized with an intravenous administration of sodium pentobarbital (25 
mg/kg of somnopentyl; Kyoritsu Seiyaku Co. Ltd, Tokyo, Japan). Next, the head was placed in a
stereotaxic frame designed originally for a rat such that the position of the head was fixed at a
horizontal level between the orbital region and the interaural line as a reference position. Then, the
skull was exposed and two small holes were drilled over the right and left regions of the brain where
dopamine-rich connections run from the substantia nigra to the striatum in the normal marmoset brain.
The regions were determined on the basis of the results of a tyrosine hydroxylase (TH) antibody
staining study in the stereotaxic atlas of the marmoset brain (Yuasa et al., 2010); positioning from the
reference point was +7.9 mm anterior from the interaural line and ±2.8 mm from the center line.

Immediately before surgery and the infusion of 6-OHDA into the brain of each marmoset in the 6-
OHDA group (n=3), desipramine hydrochloride (40 mg/kg; Wako Pure Chemical Industries Ltd,
Osaka, Japan) was administered intraperitoneally to protect the serotoninergic and noradrenergic
neurons of the animals from 6-OHDA-induced damage while allowing the specific lesioning of
dopaminergic neurons. Desipramine hydrochloride was dissolved in physiological saline to a
concentration of 2 ml/kg before its administration 1 h before surgery. 6-OHDA hydrochloride (Sigma-
Aldrich Co. St Louis, Missouri, USA) was dissolved in distilled water [with ascorbic acid (1 mg/ml)
added to prevent the oxidation of 6-OHDA] to a concentration of 1 µg/µl before its infusion into the
brain.

The tip of a 50-µl Hamilton syringe needle was placed 7.3 mm from the interaural line, slowly lowered
into the brain, and the 6-OHDA solution was infused into the right side of the brain at 40 µg for
marmoset OH01 and at 30 µg for marmosets OH02 and OH04. Immediately after the right-side



infusion into each marmoset brain, another infusion to the left region at the same dose was performed
in a similar manner. The solution was infused manually into each brain at the speed of 1 µl/s and,
subsequently, the needle was withdrawn slowly. The dose of 40 µg in one subject (OH01) produced
marked behavioral disruption (see the Results section). Therefore, the dose of 30 µg of 6-OHDA was
infused in the other subjects (OH2 and OH4). After both infusions were completed, dental cement was
placed in the burr holes, the incision was sutured and closed, and the marmosets were returned to their
individual living cages. Following the surgery, the marmosets received intramuscular administrations
of ampicillin sodium (20 mg/kg of viccillin; Meiji Seika Pharma Co. Ltd, Tokyo, Japan), and their
wounds were rubbed with oxytetracyline (terramycin ointment; Takeda Pharmaceutical Co Ltd, Osaka,
Japan). If a marmoset did not eat or drink after the brain infusions of 6-OHDA, mixed solutions of the
Meibalance (7 ml; Meiji Dairies Corp., Tokyo, Japan) and Cakesia (Morinyu Sunworld Co. Ltd, Tokyo,
Japan) supplements were given by a gavage to compensate for anorexia and dehydration. In addition,
an electrolyte fluid, KN1A (Otsuka Pharmaceutical Co. Ltd, Tokyo, Japan), was administered
subcutaneously until they had recovered sufficiently and were eating and drinking voluntarily.

Daily spontaneous motor activity in the 6-hydroxydopamine marmoset model

The daily spontaneous motor activity count of each marmoset in its individual living cage was recorded
continuously for 24 h in the consecutive days before and just after the bilateral infusion of 6-OHDA
into the brain; the activity counts of the intact marmosets, which were neither sham operated and nor
administered a 6-OHDA infusion, were recorded in a similar manner. An infrared motion sensor
(O’Hara and Co., Tokyo, Japan) attached to the ceiling of each cage detected spontaneous motor
activity by measuring spatial shifts in thermal sources (the body parts of the marmosets) and the CIEA
ACTSCAN system (Prime Lab Inc., Tokyo, Japan) was used to record and analyze the spontaneous
motor activity data.

To obtain additional information, grossly observable behavioral signs in the marmosets were recorded
using our dysfunction score system developed for MPTP model marmosets, which consisted of 11
items, including moving tremor, immobility, positional dysfunction, and others (Ando et al., 2008).
However, as this scoring system failed to detect many behavioral changes or other unexpected changes
in 6-OHDA model marmosets, these data are not reported. Instead, clearly manifested behavioral
changes by visual inspection were recorded each time they occurred.

For each drug test, the vehicle was administered first; this was followed by two doses of the drug in
ascending order, with at least 1 week between tests. For all subjects, the first saline administration in
the apomorphine test was initiated 1–2 months after the bilateral 6-OHDA infusion and the final L-
DOPA test (20 mg/kg) was performed 2.5–3.5 months after the 6-OHDA infusion. The spontaneous
motor activity counts of the intact marmosets for the L-DOPA test were obtained from a previous study
(Ando et al., 2014): the data of three intact marmosets were selected randomly from the data of six
marmosets used in the previous study. The experimental conditions for measuring the motor activity
counts were similar in the present study and the previous L-DOPA study.

Drugs

Apomorphine hydrochloride (Sigma-Aldrich Co.) was dissolved in physiological saline using an
ultrasonic mixing apparatus just before its administration. Solutions of the test doses used in this study
(0.5 and 1 mg/kg) were prepared to a volume of 2 ml/kg for each dose. Methamphetamine
hydrochloride (Sumitomo Dainippon Pharma Co. Ltd, Osaka, Japan) was dissolved in saline to a
concentration of 2 mg/ml, prepared as an original solution, kept in a locked refrigerator, and used
within 1 month of its preparation. Solutions of the test doses used in this study (1 and 2 mg/kg) were
diluted with saline before each test to an administered volume of 2 ml/kg. To prepare the L-DOPA,
neodopaston combination tablets (Daiichi Sankyo Co. Ltd, Tokyo, Japan) containing 100 mg of L-
DOPA and 10 mg of carbidopa were prepared immediately before administration by crushing a single
tablet into minute particles and suspending the particles in a 2.5% (w/v) Gum Arabic solution using
distilled water; each test dose used in this study (10 and 20 mg/kg) was prepared in a volume of 2 



ml/kg. The L-DOPA was administered orally using an intragastric tube, designed for use in human
infants, that passes the solution into the stomach of the marmoset through its mouth; a pencil was
placed in the mouth beforehand to prevent biting of the tube.

Tyrosine hydroxylase antibody staining in the brain

After the acute drug tests had been completed, the 6-OHDA-treated marmosets were deeply
anesthetized with an intraperitoneal administration of sodium pentobarbital (100 mg/kg of
somnopentyl; Kyoritsu Seiyaku Co. Ltd, Tokyo, Japan) and euthanized by exsanguination. An intact
(nonoperated) marmoset matched for body weight and age was treated in the same manner as above
and used as the control. The brains were removed, fixed in 20% buffered formaldehyde for 5–7 weeks,
and embedded in paraffin. Coronal sections prepared at a thickness of 15 µm were obtained from a
location 10 mm from the interaural line and 6.1 mm from the Bregma. Only coronal sections were
obtained in the present study as supplementary histological information accompanying the behavioral
data because the caudate and the putamen could be distinguished clearly in the striatum of the intact
marmoset brains. Immunohistochemical staining with a TH antibody (1 : 500, mouse anti-TH
MAB318; Merck Millipore Co., Billerica, Massachusetts, USA) was performed using an automated
immunostainer (Bond-MAX; Leica Biosystems Co., Mount Waverley, Victoria, Australia), and images
were captured and generated using an upright microscope (Axio Imager; Carl Zeiss Inc., Thornwood,
New York, USA).

The coronal images of the brains of 6-OHDA-treated marmosets (OH01, OH02, and OH04) and of an
intact marmoset (CM32) were analyzed quantitatively using NIH ImageJ software
(https://imagej.nih.gov/ij/). Each image was captured by the software and evaluated in the following
manner: (i) selecting ‘Image→Color→Split Channels’ and using only the blue split image, (ii) setting
the length scale in mm, (iii) tracing the outline of the whole coronal brain image as the region of
interest (ROI), (iv) selecting ‘Image→Adjust→Threshold’ and adjusting the minimum threshold to 0
and the maximum threshold to 100 because these settings yielded clear images of the striatum in the
intact marmoset brain without interference by other areas, and (v) selecting ‘Analyze→Measure’. With
these settings, the area of the image detected under the fixed thresholds (in pixels) from the whole
coronal brain was calculated in mm . To determine density differences across brain images obtained
from different tissue preparations, simplified validations were performed. Each square area (1.0×1.0 
mm) defined as the ROI was placed in the right and left cortex of the same split blue coronal images.
These square ROI areas were measured in mm  with or without thresholds.

Statistical analysis

All averaged data are presented as mean±SD. Statistical analyses were carried out only for the dose–
effect relationships obtained with the three test drugs with respect to spontaneous motor activity,
focusing on comparisons of each drug in the 6-OHDA and intact marmoset groups. These relationships
were analyzed using motor activity counts in the 90-min period following drug administration. First,
for each drug, the motor activity counts of the 6-OHDA and intact groups were compared in a three-
way (groups, drugs, and doses) analysis of variance (ANOVA) and post-hoc Bonferroni tests using the
SPSS statistical software package (version 19; IBM Corp., Armonk, New York, USA); P values less
than 0.05 were considered to indicate statistical significance. Second, for each drug, the area under the
curve (AUC) of the dose–effect relationship, measured as motor activity counts in a 90-min period,
was calculated for the two groups. The AUC was calculated for each marmoset for each of the three
test doses of each drug using the rectangle method (values of the horizontal x-axis: 1, 2, and 3 for the
vehicle, low dose, and high dose, respectively; values of the vertical y-axis: number of motor activity
counts for 90-min period). The AUC values of the 6-OHDA and intact groups for each of the three
drugs were compared with a two-way (groups×drugs) ANOVA and post-hoc Bonferroni tests using the
same statistical software package as above.

Results
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Time-course effect relationship

Influence of bilateral infusion of 6-hydroxydopamine into the brain

For ∼1 week following the infusion of 40 µg of 6-OHDA into each side of the brain, marmoset OH01
was fully incapacitated and lay on the floor of its individual living cage and, because it neither drank
water nor ate food, was supplied with supplementary food and water, as described in the Methods
section. A slight moving tremor in this marmoset was observed episodically for several weeks.
Thereafter, the tremor disappeared and visually observed motor activity subsequently increased. No
other clear neurological evidence, such as positional dysfunction, or other signs usually present in
MPTP-treated marmosets, was observed. On the basis of these behavioral observations of marmoset
OH01, 30 µg 6-OHDA infusions into each side of the brain were administered to marmosets OH02 and
OH04, instead of the 40 µg administered to marmoset OH01. These two marmosets were also
incapacitated for several days after the infusions, but to a much lesser degree than OH01. Neither
showed clear neurological signs.

The changes in the daily spontaneous motor activity counts of the three 6-OHDA marmosets are
presented in Fig. 1 (upper blocks). The motor activity counts of each marmoset varied across the days
before 6-OHDA infusion, but remained within a certain range. Following the 6-OHDA infusions, the
daily motor activity counts decreased within a few days or more. Although the activity counts of
marmoset OH01 increased progressively for several weeks, the activity counts of marmosets OH02 and
OH04 (both with 30 µg of 6-OHDA on each side of the brain) did not show this progressive increase,
notwithstanding a transient increase in the counts in marmoset OH04. The spontaneous motor activity
counts of the three intact marmosets are also presented in Fig. 1 (lower blocks); these counts were also
variable, but remained relatively stable compared with those of the 6-OHDA-treated marmosets.

Open in a separate window
Fig. 1

Changes in the daily spontaneous motor activity counts of marmosets in their individual living cages across
experimental days. 6-Hydroxydopamine (6-OHDA) was infused bilaterally into the brain of marmoset OH01
at 40 µg/side and the brains of marmosets OH02 and OH04 at 30 µg/side on experimental day 0 (upper
graphs). The daily spontaneous motor activity counts of intact marmosets (without brain lesion or 6-OHDA
treatment) are shown in the lower graphs.

Acute effects of dopaminergic drugs on spontaneous motor activity in the 6-hydroxydopamine
and intact marmosets

The present study examined the acute effects of apomorphine,
methamphetamine, and L-DOPA on spontaneous motor activity by comparing the motor activity counts
of the 6-OHDA and intact groups during each 30-min period for 180 min after the administration of the
drugs. Following the administration of vehicle (saline or gum arabic solution) in the 6-OHDA and
intact groups, the mean activity counts in each 30-min period ranged from 188.0 to 848.0 over the 180-
min test period (Figs 2–4; left sides). There were no significant increases or decreases in the counts
within each vehicle test or across the vehicle tests for the three drugs. Furthermore, there were no
significant differences between the 6-OHDA and intact groups in the vehicle tests.

https://www.ncbi.nlm.nih.gov/pmc/articles/PMC5690296/figure/F1/
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC5690296/figure/F1/
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Dose–effect relationship

Open in a separate window
Fig. 2

Time-course effects of apomorphine on the spontaneous motor activity in marmosets of the 6-
hydroxydopamine (6-OHDA) and intact groups in their individual living cages. Each data point indicates the
mean and SD of the motor activity counts (n=3 for each group).

Open in a separate window
Fig. 4

Time-course effects of L-3,4-dihydroxyphenylalanine (L-DOPA) on the spontaneous motor activity counts of
the 6-hydroxydopamine (6-OHDA) and intact groups in their individual living cages. Each data point
indicates the mean and SD of the motor activity counts (n=3 for each group).

In contrast to the vehicle tests, the administration of apomorphine (0.5 and 1 mg/kg) resulted in higher
activity counts in the 6-OHDA group during the 30–60-min period after drug administration compared
with the intact group (Fig. 2). The activity counts decreased markedly over time in both groups, but 1 
mg/kg of apomorphine produced steeper decreases in the 6-OHDA group than in the intact group.

Methamphetamine at 1 mg/kg increased motor activity counts in a time-dependent manner in the intact
group (Fig. 3), whereas 2 mg/kg of methamphetamine resulted in a slight decrease in activity counts
over time in this group. Alternatively, in the 6-OHDA group, methamphetamine at both 1 and 2 mg/kg
resulted in lower activity counts than obtained in the vehicle test group or the intact group following
the same doses.

Open in a separate window
Fig. 3

Time-course effects of methamphetamine on the spontaneous motor activity in marmosets of the 6-
hydroxydopamine (6-OHDA) and intact groups in their individual living cages. Each data point indicates the
mean and SD of the motor activity counts (n=3 for each group).

L-DOPA (10 and 20 mg/kg) did not clearly alter the activity counts of the intact group throughout the
180-min test period compared with the vehicle control (Fig. 4). However, compared with the intact
group, L-DOPA (10 and 20 mg/kg) increased the activity counts in the 6-OHDA-treated group, with
peaks occurring 30–60- or 60–90-min after drug administration.

Differences in the dose–effect relationships of the three drugs on the motor
activity of the 6-OHDA and intact groups are also presented in Fig. 5. For this analysis, the motor
activity counts during the 0–90-min period following drug administration were totaled to exclude the
biphasic effects that were observed during the longer 180-min time period. Compared with the intact
group, the 6-OHDA group showed trends toward increased motor activity counts after administrations
of apomorphine and L-DOPA and a trend toward decreased motor activity counts after the
administration of methamphetamine.
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Statistical analysis of activity counts and area under the curve of spontaneous motor activity

Gross behavior observation

Open in a separate window
Fig. 5

Dose–effect relationships of the three test drugs on the spontaneous motor activity counts of the 6-
hydroxydopamine (6-OHDA) and intact groups in their individual living cages. Each data point indicates the
mean and SD of the motor activity counts during the 90-min period following drug administration (n=3 for
each group). Post-hoc Bonferroni tests of the values for the area under the curve (AUC) indicated a
significant decrease in the 6-OHDA versus the intact group in the methamphetamine test and a significant
increase in the 6-OHDA versus the intact group in the L-DOPA test. In the apomorphine test, a tendency
toward a higher AUC in the 6-OHDA versus the intact group was observed, but there was no statistically
significant difference between the 6-OHDA and the intact group. For details of the AUC analysis and the
statistical tests, see the Statistical analysis of activity counts and area under the curve of spontaneous motor
activity section. p.o., oral (intragastric) administration; s.c., subcutaneous administration.

Data on the
dose–effect relationships (Fig. 5) were analyzed statistically in terms of (i) spontaneous motor activity
counts and (ii) the AUC on the basis of the dose–effect relationships of the counts. In the analysis of
spontaneous motor activity counts, a three-way analysis of variance (groups, drugs, and doses) showed
a significant effect of drugs [F(2,44)=5.53, P<0.01, and power=0.83] drugs×groups interaction
[F(2,44)=7.78, P<0.001, and power=0.94], but no significant effect of groups or doses. The post-hoc
Bonferroni tests of motor activity showed significant differences between groups (6-OHDA vs. intact)
in the methamphetamine [F(1,4)=8.05, P<0.05, and power=0.57] and L-DOPA [F(1,4)=14.63, P<0.02,
and power=0.82] tests, but not in the apomorphine test.

In the statistical analysis of the AUC, a two-way (groups and drugs) ANOVA showed a statistically
significant difference between the 6-OHDA and intact groups [F(3,2)=30.04, P<0.05, and
power=0.79]. The post-hoc Bonferroni tests of the AUC values indicated a significant decrease in the
6-OHDA group treated with methamphetamine versus the intact group [F(1,4)=9.07, P<0.05, and
power=0.62] and a significant increase in the 6-OHDA group in the L-DOPA test versus the intact
group [F(1,4)=13.98, P<0.02, and power=0.80]. There were no statistically significant differences
between the 6-OHDA and intact groups in the apomorphine test, although the AUC showed a tendency
to increase in the 6-OHDA group versus the intact group.

In evaluating the utility of the 6-OHDA marmoset model, spontaneous
motor activity was used as a primary measure, but gross behavioral changes after the different drug
administrations were also recorded. Apomorphine, at both 0.5 and 1 mg/kg, induced head twitches and
vomiting in some marmosets without a clear differentiation between the two doses. Methamphetamine
at 1 and 2 mg/kg caused hypervigilance in some marmosets in each group. L-DOPA at 10 and 20 mg/kg
produced naturalistic active movements without hyperexcitation in the marmosets of the 6-OHDA
group, but did not cause behavioral changes in the intact marmosets.

Immunohistochemical staining

In addition to assessing the behavioral effects of the drugs, a histological study was carried out by
histochemically staining the marmoset brain tissues with TH antibody (Fig. 6). A brain slice from the
intact group showed clear indications of dopaminergic neurons in the putamen and caudate of the
striatum, whereas in coronal brain slices from the 6-OHDA-treated marmosets (OH01 and OH04),
there was a loss of striatal neurons. In the brain tissue sample of 6-OHDA-treated marmoset OH02,
there was a slight loss of striatal neurons compared with the two tissue samples of the other 6-OHDA-
treated marmosets.
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Open in a separate window
Fig. 6

Coronal brain sections of marmosets from the 6-hydroxydopamine (6-OHDA) and intact groups. The three
marmosets that received brain infusions of 6-OHDA were tested to determine the acute effects of
apomorphine, methamphetamine, and L-DOPA on spontaneous motor activity in the present study. The intact
marmoset (CM32; neither 6-OHDA-infusion nor brain lesioning) was one of the three intact marmosets tested
to determine the acute effects of L-3,4-dihydroxyphenylalanine. For 6-OHDA-infused brain regions, see the
Methods section. Dopaminergic neurons were stained using tyrosine hydroxylase immunohistochemistry;
scale bar on the right below each brain: 5.0 mm.

These images were digitized and analyzed quantitatively. The striatal area within the thresholds became
distinct in the brain of the intact marmoset CM32 and measured 36.7 mm . By contrast, the areas
within the same thresholds of the 6-OHDA-treated marmosets OH01, OH02, and OH04 were 12.8,
24.9, and 9.7 in mm , respectively. Thus, the brain areas of all 6-OHDA-treated marmosets were
smaller than the area of the intact marmoset, indicating neural loss in the former. In the simplified
background validations across each brain tissue image, a 1.0×1.0 mm area placed on the right and left
sides of the cortex was 0.0 mm  in all four brain tissue images observed at the same thresholds. The
mean and SD of the square areas in the split blue images (see the Methods section) without any
threshold were 179.9±13.3 mm  in the four brain images (coefficient of variation=0.074), indicating
only small background variability across brain tissue images.

Discussion

The primary aim of the present study was to examine the behavioral effects of three typical
dopaminergic drugs using 6-OHDA-treated marmosets. Bilateral infusion of 6-OHDA resulted in mild
damage to dopaminergic neurons in the marmoset brain. Brain damage was also assessed by a
quantitative analysis of TH-stained brain tissues, which showed variable amounts of damage in tissues
from the three marmoset brains. Differential effects of the dopaminergic drugs, which differ in their
pharmacological actions, on the spontaneous motor activity of the 6-OHDA-treated marmosets versus
6-OHDA-free intact marmosets were found. Thus, 6-OHDA-treated marmosets administered
apomorphine tended to show a brief behavioral sensitization that may have been associated with the
denervation supersensitivity of dopamine receptors because of the 6-OHDA-induced degeneration of
dopaminergic neuroterminals (Kostrzewa et al., 2015). However, supersensitivity at the receptor level
is considered to be secondary and to fluctuate dynamically over time, which suggests that this change
in sensitivity is subtle. The brief behavioral effects observed in the present study are consistent with
this idea, although, because of a lack of statistical significance, it is not possible to firmly connect the
behavioral changes to denervation supersensitivity at the receptors. The administration of
methamphetamine resulted in a decreased level of motor activity in 6-OHDA-treated marmosets
compared with intact marmosets, which suggests limited dopamine release from the 6-OHDA-induced
degenerated dopaminergic neurons (Balcioglu et al., 2003). This explanation assumes that motor
activity is increased by excessive dopamine release within the dopaminergic system of the brain
(Hattori et al., 1996). Finally, the administration of L-DOPA resulted in an increased level of motor
activity in the 6-OHDA-treated group compared with the intact group, which suggests that exogenous
L-DOPA contributes toward dopamine synthesis only in degenerated dopaminergic neurons
(Abercrombie et al., 1990).

The present findings indicate that the behavioral effects of the three dopaminergic drugs can be
assessed in a sensitive, qualitative, quantitative, objective, automated, and simple manner by
comparing the motor activity data of 6-OHDA-treated and intact marmosets without the need to
remove the animals from their cages. Measurement of spontaneous motor activity in animals left in
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their living cages has several advantages over measurements recorded with the animals in external
activity test chambers, where they must first become habituated to the new environment. Thus, the
motor activity counts of already habituated marmosets are more likely to yield sensitive and clear
results (Tamborini et al., 1989).

Support for our choice of the measurement of spontaneous motor activity in the cages comes from our
previous study in which we used PET to show that the binding potential of [ C]PE2I, a radioligand for
dopamine transporters, in the striatum correlated strongly with spontaneous motor activity
(locomotion) in MPTP-treated marmosets. The correlation coefficient between the motor activity count
and the binding potential at the putamen in the striatum was 0.97 in five marmosets (Ando et al., 2012).
We therefore chose to measure spontaneous motor activity as an indicator of behavioral manifestations
in the present study.

Compared with the above-mentioned objective measurements of motor activity counts, the visual
inspection of gross behavior on the basis of the score system in the present study could not detect clear
and consistent differences in the effects of the drugs between the 6-OHDA and intact groups. By gross
behavioral observation recording only clearly manifested changes, such effects as vomiting after
apomorphine and hypervigilance after methamphetamine were observed in both groups of marmosets,
whereas naturalistic active movement without hyperexcitation was observed only after L-DOPA
administration to the 6-OHDA group. Moreover, these changes after apomorphine and
methamphetamine were observed in some marmosets in each group, but never in all three of the 6-
OHDA marmosets and, when observed, not in a dose-dependent manner. Nevertheless, the visual
inspection of gross behaviors may be an important consideration when used in combination with the
objective measurements of spontaneous motor activity so as to not overlook any potential
consequences of changes in motor activity.

In the marmoset model used in the present study, 6-OHDA was infused into a dopamine-rich area of
the midbrain that, on the basis of the rich TH-stained area reported in the marmoset brain atlas, is
considered to be an appropriate target for this toxin (Yuasa et al., 2010). Furthermore, this brain region
links the substantia nigra to the striatum. TH staining of the marmoset brains in the present study
indicated that the doses of 6-OHDA resulted in relatively mild damage to dopaminergic neurons, albeit
with individual variability. In our previous studies, greater damage was observed in the brains of
marmosets treated with MPTP, with less individual variability (Ando et al., 2008, 2012).

Variable degrees of brain damage in the 6-OHDA marmosets in this study were observed in the TH-
stained coronal sections, as confirmed by a quantitative analysis of the TH-stained area in the striatum.
The brains of two 6-OHDA-treated marmosets (OH01 and OH04) were clearly damaged, whereas less
damage was detected in the brain of the third marmoset (OH02). Even in the brain of marmoset OH02,
however, evident damage was confirmed quantitatively relative to the brain of the intact marmoset
(CM32). The two 6-OHDA-treated marmosets with clearly damaged brains had a slow but progressive
and temporal recovery in daily spontaneous motor activity after the direct infusions. The marmoset
with the less damaged brain (OH02) manifested neither a progressive nor a temporal increase in motor
activity counts. The behavioral changes in the three marmosets seemed to correspond with the degree
of brain damage, although no consistent tendency in sensitivity changes to the dopaminergic drugs
depending on the degree of brain damage could be identified in acute drug tests.

The substantia nigra, as the nucleus from which A9 dopaminergic neurons arise, may be the ideal target
area for 6-OHDA infusion, but it is small and an accurate infusion is difficult. However, the striatum
seems to be large enough to serve as an infusion target, but this area is the terminal region of neurons
from the substantia nigra and consists of the putamen and the caudate, which have different functional
roles. The medial forebrain bundle is another potential target area for the infusion of 6-OHDA that has
been previously and generally used in rodent and marmoset studies; in this region, the nerve bundles
are large enough to be accurately targeted, and the neural tracts extend from the substantia nigra to
other dopaminergic neurons, including those in the striatum (Henderson et al., 1998; Iancu et al.,
2005). However, as discussed above, we chose the dopamine-rich area of the brain that is directly
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targeted by 6-OHDA. Our study also showed that dopaminergic neural damage in the marmoset cannot
be assessed by TH staining alone, but must be accompanied by further analyses. However, compared
with rodent models, there are relatively few studies in which the 6-OHDA marmoset model has been
used.

As described previously in the Introduction section, our previous unpublished findings using a
marmoset model of unilateral brain infusion of 6-OHDA showed that marmosets clearly show
contralateral circling behavior after the administration of dopamine agonists, such as apomorphine, but
there is no consistent ipsilateral circling after the administration of methamphetamine. By contrast,
using qualitative and quantitative measurements, we clearly observed both types of circling behavior in
6-OHDA-treated rats with unilateral brain damage that were administered apomorphine and
methamphetamine (Inaji et al., 2005). The neural networks in the marmoset brain are considered to be
more complicated than those in the rodent brain. Therefore, it is possible that the marmoset brain
engages various compensatory mechanisms after 6-OHDA-induced damage rather than continuing to
rely on degenerated neurons as in the rodent brain. This may explain why there were clear differences
in the circling behavior of the rodents but not of the marmosets following the administration of
dopamine-releasing drugs (e.g. methamphetamine). Thus, if the primary aim of a study is to assess
differential circling behaviors following the administration of dopamine agonists and/or dopamine
releasers, a rodent model may be more suitable than a marmoset model. However, if the primary aim is
to detect a PD-like syndrome, such as immobility and moving tremors because of clear dopaminergic
neural degeneration, the MPTP marmoset model may be more suitable (Eslamboli, 2005; Jenner,
2009). Nevertheless, the 6-OHDA marmoset model may offer several advantages when investigating
the functional roles of specific brain areas following the degeneration of dopaminergic neurons. In
addition, this model may be useful for other types of research, using behavioral measures other than
circling, and may yield novel insights in preclinical studies. Toxin-induced marmoset models of PD
have contributed toward the current understanding of this disorder, aided in the evaluation of various
treatments for PD, and will contribute as active control models for the development of a transgenic
model of marmosets expressing human PD genes (Eslamboli, 2005; Sasaki et al., 2009).

Finally, the present study has several limitations that should be mentioned. First, there were relatively
few 6-OHDA-treated subjects (n=3), and more data would have better supported the findings. Second,
the phase of neural degeneration associated with 6-OHDA and its compensatory mechanisms is
considered to be progressive and variable as time passes; thus, the behavioral testing period after the
infusion of 6-OHDA is critical for consistent results. Further studies investigating progressive changes
in brain damage are needed to better examine the utility of the 6-OHDA marmoset model. Third, more
detailed brain histological and neural investigations are necessary to clarify the reason for variability in
the TH-stained data, for example, by focusing on the change in the dopamine transporter sites in the
caudate and putamen in these marmoset brains. It would also be interesting to observe whether nerve
fiber sprouting did occur in the striatum of the 6-OHDA-treated brain. Fourth, direct infusion of 6-
OHDA into the substantia nigra pars compacta of the marmoset brain may be preferabe. This may be
possible with more skillful infusion technique because, even though body weights are similar, the brain
of the marmoset is larger than that of the rat.

Conclusion

The present study identified differential behavioral effects among dopaminergic drugs with different
pharmacological actions using the common marmoset with mild damage to the dopaminergic neural
system in the brain induced by 6-OHDA. The utility of this marmoset model with bilateral 6-OHDA
infusions was shown for the stated purpose of clarifying the behavioral pharmacological properties of
dopaminergic drugs.
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